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Preface

Thank you for purchasing Sonocat, a hand-held measurement device for
measuring sound pressure, intensity/power and in-situ absorption! This user
manual will guide you through all the capabilities and full advantages of
Sonocat to guarantee that you will use Sonocat at its best. Please read this
document carefully before using Sonocat.
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1 Precautions and safety considerations

Before using Sonocat, please be aware of the following precautions and
safety considerations:

• Use Sonocat and its accessories as a hand-held, high-end measure-
ment device and treat it carefully.

• Please DO NOT TOUCH the sphere under any conditions, and specifi-
cally the holes in the sphere, as in that event the microphones behind
the holes can be permanently damaged by static pressure build-up.

• Please do not expose Sonocat to sound pressure levels above 120 dB(A),
as the microphones can be permanently damaged above this level.

• Please use proper ear protection when measuring in (too) noisy envi-
ronments.

• Keep Sonocat and its accessories away from water and dust.

• Avoid damaging Sonocat and its accessories. Avoid Sonocat impacting
with hard surfaces.

• Avoid any contact of the sphere with other objects/surfaces. Only store
Sonocat and its accessories in its box or on a table.

• Soundinsight BV is not responsible for any damage due to above listed
events or due to any other improper use of Sonocat and its accessories.
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2 Introduction

Sonocat contains eight digital micro-electro-mechanical system (MEMS) mi-
crophones in a spherical (array) enclosure. The diameter of the sphere is
30mm. The number of microphones and their positioning on the sphere al-
low Sonocat to capture the acoustic field in 3 dimensions.

Thanks to a precise and elaborate calibration, Sonocat measures the pressure
level and the intensity level in the three directions, i.e. x y and z. It is able to
calculate the sound power and the sound absorption coefficient of a material
in real-time by simply scanning its surface.

Sonocat comes along with the Sonocat Software to monitor, record and anal-
yse the captured soundfield.

3 Suitcase contents

Sonocat and its accessories are delivered in a suitcase, which protects its con-
tents from shocks, dust and water. You will find the following items inside:

1. the Sonocat

2. USB Sonocat connection cable

3. USB flash drive (black colored) with the Sonocat Software installer, the
USB driver, the calibration report, the user manual and your Firm Code

4. the calibration report

4 Installing software and drivers

The software and drivers for Sonocat and the Sonocat Software are delivered
on the USB flash drive in the suitcase. To install the software and drivers, in-
sert the drive into your workstation (PC/Laptop) and open its folder. The fol-
lowing files are present:

• sonocat_software_installer_v1.1.9.6.exe
The Sonocat Software installer.

• sonocat_software_user_manual_v1.1.9.6.pdf
This user manual.

• zadig_2.7.exe
The USB device driver installer.

• cal_report_SC#####.pdf
The calibration report for this particular Sonocat with serial number
SC#####.

• #####
The Firm Code, needed to generate a license key for your PC.

Note: we require a Windows operating system (7 SP1 or higher) with 64-bits
instruction set, see also the system requirements in Section 10.3.

→ Section 10.3
The next steps will guide you through the installation process of the Sonocat
Software. Please allow the program to make changes to your computer.
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4.1 Installing the device driver

If this is a first time install of the Sonocat Software, you also need to install
the WinUSB driver as described in this section. You can skip this step if the
WinUSB driver is already installed on your system.

The Sonocat USB connection uses the LibUSB library to communicate over
USB. Therefore, the WinUSB driver needs to be installed, which is done using
Zadig. Please connect the USB cable to the Sonocat first and then to the
workstation. Now install the driver by executing zadig_2.7.exe, which you
can find on the USB drive provided in the suitcase.

Note: sometimes Windows Update will block Zadig from installing the driver.
In this event, please temporary quit Windows Update in the system tray.

The following dialog will appear:

Please click No. If the Sonocat is connected, Zadig will automatically detect
the Sonocat spherical microphone array (if the Sonocat is not detected,
please enableOptions > List All Devices and disableOptions > Ignore Hubs
or Composite Parents):

Please click Install Driver.

Please wait until the driver installation was successfull.
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If you see this figure, the driver is installed correctly. You can now close Zadig.

4.2 Installing the Sonocat Software

Please locate the sonocat_software_installer_v1.1.9.6.exe file and
double-click on it. A wizard will now guide you through the installation pro-
cess. The following dialog will appear:

Please click Next.
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Please read the license agreement carefully and, if agreed, select I accept the
agreement and click Next.

Please select the installation location and click Next.
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Optionally, you can choose to put a shortcut on the desktop. If you wish to
have one, please check Create a desktop shortcut. Please click Next.

Please click Install.
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Please wait until the installer is finished.

The installation is finished. Optionally, you can choose to directly launch the
Sonocat Software by checking Launch Sonocat Software. Please click Finish
to exit the installation.

Congratulations, you have successfully installed the Sonocat Software!

4.3 Sonocat license

To run the Sonocat Software a license key is required, specific for the PC used
to run the application. During start-up of the Sonocat Software the availabil-
ity of a license key is verified. If there is no license key available one needs
to be generated and installed on the PC. To generate a key, two items are
needed:
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• a Firm Code, which is specific to your company

The Firm Code can be found on the USB stick and on the Welcome!
sheet both found in the Sonocat case on delivery.

• a client key, which is specific to your PC and will be generated by the
Sonocat Software

The client key is generated and displayed by Sonocat Software when
no license key is found.

Note: license keys are bound to a specific PC. There are five license keys avail-
able for each Sonocat and Firm Code. Additional license keys are available for
purchase from support@soundinsight.nl.

The following dialog will appear at startup of the Sonocat Software if no li-
cense key is found:

To obtain a license key, please send an email containing your Sonocat Soft-
ware Firm Code as well as the client key as given below to licensing@soundinsight.nl
In return you will receive an email containing the license key for your PC. The
client key can be copied to the clipboard by clicking Copy client key to clip-
board.

To store the received license key, please click Next.
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Enter the license key as received by email in the indicated text box. The li-
cense key can be stored by clicking Store license key. Thereafter click Finish to
finish the licensing. The Sonocat Software starts after finishing the licensing
successfully.

You have successfully licensed the Sonocat Software! Note that this proce-
dure is needed only once. After storing the license key, the Sonocat Software
does start without interruptions on the licensed PC.
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5 Connecting Sonocat

To use Sonocat, you have to connect Sonocat to a workstation (laptop/PC)
with the installed Sonocat Software and device drivers. Sonocat cannot be
connected earlier than when the operating system has been fully booted.
Once the operating system is running, please first connect the USB cable to
Sonocat and then to the workstation.

Once Sonocat is connected to the workstation, DO NOT touch the sphere
of Sonocat as it will negatively affect your measurements or even damage
Sonocat. See also Section 1.

→ Section 1

The state of Sonocat is shown in the status bar of the Sonocat Software, see
figure above, and knows four states:

• idle
The Sonocat is connected to the workstation and is in its idle state.

• streaming
The Sonocat is connected to the workstation and is streaming data.

• error
An error occurred. Please restart software and replug Sonocat.

• disconnected
Sonocat is not connected to the workstation.

Furthermore, the firmware version, model number and serial number are dis-
played in the Sonocat information box. If no Sonocat is connected, no infor-
mation is displayed here.

Note: The time to start up a Sonocat connection may last up to about ten sec-
onds when plugging into a workstation.

6 Sonocat Software

The Sonocat Software is dedicated to Sonocat measurements and its inter-
face allows the user to monitor, record and analyse the data collected by
Sonocat.
The Sonocat Software can be used with or without plugging in Sonocat;
however, Sonocat cannot be used without the Sonocat Software.

The Sonocat Software comprises a graphical user interface with its function-
alities provided in four panels (outlined vertically on the left side of the main
window; see figure below):

• Project

• Monitor
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• Measure

• Analyse

Switching between the different panels is possible in any order.
Moreover, a menu bar has two main menus called File and Tools. The File
menu allows to create, load and save your project. The Tools menu provides
access to the Waveform generator and the Sensor inspector. The functionality
of these tools is explained in Section 6.5 and 6.6.→ Section 6.5 and 6.6
Furthermore, a status bar provides the Sonocat status, which can be either
idle, streaming, error or disconnected as explained in Section 5.→ Section 5

All Sonocat measurements are grouped into projects. A project is created,
loaded or saved by clicking on the File menu and selecting New project, Load
project or Save project respectively.

Note: A Sonocat project file (*.sip) can directly be opened by the Sonocat Soft-
ware by double-clicking on the file in the operating system’s file manager.

6.1 Project panel

The Project panel displays an overview of the Project information, but also
provides the Measurement files overview together with the Sonocat informa-
tion.

6.1.1 Project information

In the Project information box most fields are editable, some are read-only:

(read-only) indicates the filepath of the folder in which the project is stored.Filepath:
The filepath will indicate *temp in case the project has not yet been saved yet.

(read-only) shows the filename of the project. The filename will indicate *un-Filename:
saved_project in case the project has not yet been saved. The filename and
filepath are defined when the project is created or loaded under Menu > File

(editable) where you can specify the measurement operator(s).Operator:

(editable) where you can enter the location where the measurements haveLocation:
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been done.

(editable) where you can fill in the date at which the measurements have beenDate:
performed.

(editable) Any noteworthy comments and other user-defined metadata canProject comment:
be conveniently stored here.

6.1.2 Measurement files overview

The measurements that belong to the current project are listed in the Mea-
surement files overview box, as displayed in the right side of the window.

When a measurement is saved, a folder Measurements is created at the same
location of the project file (*.sip) and the measurement (*.sim) is stored in
it. Besides the above mentioned metadata, a project file (*.sip), stores a
"weak link" (i.e. relative file location path) to each measurement (*.sim) be-
longing to the project. This allows the user to copy and move measurements
using the file manager of the operating system.

Once a project has been loaded, a check will be done to see if all measure-
ment files are still in place. If not, the user can relocate the files by clicking on
the Import button, or optionally, remove the files from the project by clicking
on the Remove button.
The Remove button withdraws measurement files from the project by remov-
ing the ’weak link’ of the selected measurement from the project file. In this
case the measurement file is still on the hard disc drive. However, you can op-
tionally choose to also remove the measurement file from the hard disc drive.
The measurement file will then be moved to the operating system’s trash bin.

The Edit/View button allows to change options for a measurement file in a
new dialog. More information will be provided in Section 6.4.1→ Section 6.4.1

6.1.3 Sonocat information

The Sonocat information box provides information about the connected
Sonocat. If no Sonocat is connected, the (read-only) fields show ’N/A’.

This is the version number of the embedded software which runs on a digitalFirmware version:
signal processor inside the connected Sonocat.

This number indicates the model and configuration of the connected Sono-Model number:
cat.

This number is a unique identifier of the connected Sonocat.Serial number:

Note: Besides this information, Sonocat Software obtains probe configuration
including microphone positions, sensitivities, calibration data, sample resolu-
tion and available sample rates from Sonocat. A copy of all this information is
stored in each measurement, such that measurement files are exchangeable
between different users of Sonocat Software for postprocessing. This also al-
lows for combining measurements from different Sonocat’s. See Section 6.4.2
for more information.
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6.2 Monitor panel

In the Monitor panel, the different quantities of the sound field measurable by
Sonocat (e.g. Sound Absorption Coefficient) can be monitored in real time.
Measurement results are shown in the frequency domain using spectral aver-
aging over short time blocks, where the Update interval of these blocks can be
configurated in Settings. After a time block has been processed, the figure is
updated automatically. The frequency spectrum of complex quantities, like
Impedance, is presented in the form of a Bode plot. So, besides the magni-
tude of the frequency spectrum also the phase of the spectrum is shown.

Note: the Monitor panel is intended to give a quick view of the measured quan-
tity. For an actual measurement of the quantity of interest, it is recommended
to perform a measurement using the Measure panel.

6.2.1 Settings

For monitoring the sound field, you can choose three Update frequencies:Update interval:

Interval FFT length Number of averages Update frequency
Fast 512 5 8 Hz
Medium 512 20 3 Hz
Slow 1024 30 1 Hz

Switching the update frequency can be done while monitoring. The changes
you make will affect the results instantly. If performance issues arise due to
the Sonocat Software not being able to perform all of its calculations within
the allotted time frame as determined by the update frequency, resampling is
performed on the signal. This can result in the temporary loss of one or more
of the higher frequency bands (this only happens during real-time monitor-
ing, not when performing a measurement from the Measure panel). For more
information about the FFT length and Number of averages settings, please re-
fer to Section 6.3.1.→ Section 6.3.1

6.2.2 Plot

The monitoring quantity can be selected here. The options show the sameQuantity:
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list as in the Analyse panel and are explained in Section 6.4.2.→ Section 6.4.2

We provide the options to display the data in octave bands, 1/3 octave bands,Frequency band:
1/6 octave bands, 1/12 octave bands, and narrow band (PS - power spectra and
PSD - power spectral density).

The frequency weighting can be to set A-, C- and, a so-called, Z-weightingWeighting:
(please check Section 9 for explanation about weighting).→ Section 9

Changes made to these settings will affect the next update of the figure in the
Results box.

6.2.3 Results

The Results box shows the current result of the Monitor panel settings. The
buttons and configuration of the Results box are the same as in the Measure
and Analyse panels and are described in Section 6.4.3.→ Section 6.4.3

6.3 Measure panel

Clicking on the Measure tab, the following panel is shown:

On the left side, settings for the measurement can be set in the Settings box.
Next, a recording can be initiated in the Record box. On the right side, the
Results box will display the result after the measurement is finished.

6.3.1 Settings

Although Sonocat records eight temporal signals, all the analyses of the mea-
surements are performed in the frequency domain. The temporal signals are
cut in blocks of defined length, windowed and transposed to frequency bins
via FFT. This process is repeated for the length of the temporal signals. The
length of the temporal signals, and therefore, the duration of the measure-
ment are influenced by the settings. Most fields are editable, some are read-
only and are given as a ‘result’ based on the given settings.

(read-only) The sampling frequency of Sonocat is 48 kHz, i.e. 48,000 samplesSample frequency:
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per second are recorded for each microphone. This setting is fixed and cannot
be changed.

The temporal signals are cut in blocks of length defined by this setting. For theFFT length:
number of samples in a window, you can choose the following FFT lengths:
512, 1024, 2048, 4096 and 8192 samples. The bigger the number of samples,
the more detailed the measurement. A default value of 4096 is set.

(read-only) As a result, you will find the frequency resolution = sampleFrequency resolution:
rate/FFT length. The frequency resolution determines the narrow-band res-
olution of the power spectrum. A narrower frequency resolution results in
more accurate low frequency result at the price of longer measurement times
according to the bandwidth×time principle.

The number of windows that will be averaged in the spectral estimator canNumber of averages:
be specified with a value between 1 and 10000. The Sonocat Software has a
default value of 100 averages. The higher the value, the more data is recorded.

Specify the overlap percentage of two windows in the range of 0-90%. WithOverlap percentage:
a Hanning window with 50% overlap the entire signal is analysed (no signal
loss).

(read-only) As a result, you will find the recording time = ((1 - overlap per-Recording time:
centage/100) × number of averages + overlap percentage/100) × FFT length
/ sampling frequency.

Choose the window type you want to apply to each time block: Hann, Ham-Window type:
ming, Rectangular, Bartlett or Blackman. The energy loss due to windowing
is compensated for in the spectra estimation.

The temperature has to be specified in degrees Celsius. The temperature willTemperature:
be used to calculate the speed of sound.

Specify the relative humidity in this field. The relative humidity will be usedRelative humidity:
to calculate the speed of sound.

Enter the atmospheric pressure in Pascal here. The atmospheric pressure willAtmospheric pressure:
be used to calculate the speed of sound.

The scan area will be used to either calculate the sound power or the area-Scan area:
averaged sound absorption, intensity or pressure.

Any text commented here will be stored as part of the measurement and canMeasurement comment:
be retrieved in the Edit/View dialog, see also Section 6.4.1.→ Section 6.4.1

The Reset button can be used to restore the latest saved measurement set-
tings.

Note: The implemented model used to compute the speed of sound in air and
the air density is as described by Cramer [1].

6.3.2 Record

In the Record box you can start the recording by pressing the Record button.
In the Start delay field one can specify a time delay; the actual recording starts
after this time delay. Three beep signals will be played after pressing the
record button to indicate that:

1. The start delay is initiated.
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2. The start delay has ended and the actual recording has started.

3. The recording has ended.

The beep itself is not recorded in the measurement. However, the user can
enable/disable the beeps by (un)checking the Start/stop beep box. Once the
record button is pressed, provided that Sonocat is connected, the following
dialog will be shown:

This dialog indicates the progress of the start delay and the recording. Press
the Cancel button if you wish to cancel the current recording before the
recording has ended. When the recording finishes, the following dialog will
appear:

Here, you can either choose to Save the measurement, or Discard it. When
you press save, the measurement is saved as part of the project, with the
name as entered in the field. When the project has not been saved yet, you
will be asked to save the project first. After the project has been saved, the
measurement will be saved as well.

Note: As the measurement is part of the project, the project needs to be saved
first in order to store the link between the measurement file and project. To save
the project after a measurement, press CTRL-S, or use File > Save project.

6.3.3 Results

After a measurement is finished, the result is shown in the graph of the Results
box, where the quantity as chosen in the Monitor panel is plotted.
If you are interested in showing a different quantity of the same sound field,
you can select a different quantity in the Analyse panel. You can interact with
the results graph in the Results box. The buttons are the same as in the Analyse
panel and will be discussed in Section 6.4.3.→ Section 6.4.3
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6.4 Analyse panel

The Analyse panel is used to compute, analyse, compare and combine mea-
surement results. The analysis is performed in the frequency domain on the
selected measurement file(s) for the desired quantity with the chosen fre-
quency band resolution and weighting. The selected measurements can be
analysed separately or combined.
The measurement analysis can be performed straight after a measurement
or remotely without plugged in Sonocat .

6.4.1 Measurement selection

The Measurement selection box shows an overview of the measurements in
the project. If no measurements are available, the Measurement selection box
shows No measurement files in this project.
The Import, Edit/View and Remove buttons have the same functionality as in
the Project panel. However, in contrast to the Project panel, multiple mea-
surements can be selected in the Analyse panel and the buttons operate on
all selected measurements. This way, operations can easily be executed on
multiple measurements.

The Import button will help to localise the measurement file you want to im-
port and the Remove button will withdraw the measurement from the project.
Pressing the Edit/View button opens the Edit/View measurement dialog (see
figure below) where the measurement settings can be adjusted.
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The measurement name can be edited. The measurement name is the fileMeasurement name:
name without its file extension (*.sim). When the measurement name is
changed, also the filename will be changed.

The measurement settings can be viewed and/or changed. As explained inSettings:
Section 6.3.1, the recording time is a result of the FFT length, number of av-→ Section 6.3.1
erages and overlap percentage. It is therefore only possible to adjust the FFT
length and overlap percentage. The number of averages corresponding to the
recording time is then changed accordingly.

In this box you can press the Export audio data button to export the uncal-Export:
ibrated audio data of the microphone signals as wave files (*.wav), FLAC
(*.flac) or ASCII data (*.dat).

6.4.2 Export/Plot

The options for the analysis of the measurements are set in the Export/Plot
box.

With this drop-down list you can select the quantity to export/plot. The the-Quantity:
oretical principles behind these quantities are developed in the glossary in
Section 9. The current version of the software offers:→ Section 9

• Sound absorption coefficientα. The range ofα goes from -1 to 1; where
-1 reflects a fully emitting surface, 0 a fully reflective surface and 1 a fully
absorbing surface.

• Impedance in Pa s/m (in the x-, y- and z-direction in a Cartesian coor-
dinate system). The impedance spectrum will be presented as a Bode
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plot. The impedance is only available for the narrow band (PS/PSD,
which makes no difference for an impedance) and Z-weighting.

• Sound intensity direction (θ and ϕ coordinate of the intensity vector in
a spherical coordinate system displayed in degree). See Section 7.1 for→ Section 7.1
a graphical representation of the coordinate system.

• Sound intensity level, in dBSIL (x-, y- and z-coordinate of the intensity
vector in a Cartesian coordinate system, and its vector magnitude). See
Section Section 7.1 for a graphical representation of the coordinate sys-→ Section 7.1
tem. The sound intensity in a certain frequency band can have either
a positive or negative value indicating the direction of the net sound
energy flow per unit area. In the former case (i.e. for positive values)
the bar colors are uniform, in the latter case the bars are hatched and
the color is more transparent. The (−) sign in front of the overall value,
which is shown on top of the overall bar, indicates energy flow in the
negative direction.

• Power emitted/reflected in dBSWL. This is the sound power of a scan
area in the positive direction of the z-plane of the Sonocat. Scanning
a surface with the Sonocat (with the z-direction of the Sonocatperpen-
dicular to the surface) it represents the sound energy, integrated over
the area, coming from that surface, either because that surface reflects
incident sound and/or that surface radiates sound. The mathematical
difference of the emitted/reflected power and the immitted/incident
power is the (net) power in the z-direction. The scan area, in square me-
ter, is a setting in the Measure panel and can be changed for a saved and
loaded measurement with the Edit/View button in the Analyse panel.
Note: when monitoring, the scan area is set to 1 m2, which means that
the sound power is identical to the sound intensity.

• Power immitted/incident in dBSWL. This is the sound power of a scan
area in the negative direction of the z-plane of the SonocatṠcanning
a surface with the Sonocat (with the z-direction of the Sonocat per-
pendicular to the surface) it represents the sound energy, integrated
over the area, towards that surface. The mathematical difference of the
emitted/reflected power and the immitted/incident power is the (net)
power in the z-direction. The scan area, in square meter, is a setting
in the Measure panel and can be changed for a saved and loaded mea-
suremen with the Edit/View button in the Analyse panel.
Note: when monitoring, the scan area is set to 1 m2, which means that
the sound power is identical to the sound intensity.

• Partical velocity level in dBPVL (in the x-, y- and z-direction in a Carte-
sian coordinate system).

• Sound power level, in dBSWL (relative to 1pW). The sound power in a
certain frequency band can have either a positive or negative value in-
dicating the direction of the net sound energy flow. In the former case
(i.e. for positive values) the bar colors are uniform, in the latter case
the bars are hatched and the color is more transparent. The (−) sign
in front of the overall value, which is shown on top of the overall bar,
indicates energy flow in the negative direction. The user is able to mea-
sure the Sound Power Level in the z-direction of a Cartesian coordinate
system only.
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• Sound pressure level, in dBSPL.

• Sound pressure-intensity index in dB (for the x-, y- and z-component
of the sound intensity vector in a Cartesian coordinate system, and for
the magnitude of the sound intensity vector)

We provide the option to bin the data in octave bands, 1/3 octave bands, 1/6Frequency band:
octave bands, 1/12 octave bands, and narrow band. The latter option can be
plotted either as power spectra or power spectral density.

The frequency weighting can be set to A-, C- and, a so-called, Z-weighting ac-Weighting:
cording to [2]. The latter actually means no frequency weighting.

Note: For relative quantities, such as the absorption coefficient and pressure-
intensity index, the weighting value has no effect on the output. See also
Section 8.→ Section 8

This drop down list determines how the results are plotted or exported. TwoExport/Plot:
options are available:

• Separately:
When Separately is selected, the exported/plotted results will be shown
as a comparison. For each selected measurement, the selected Quan-
tity will be exported/plotted. This options is used to compare different
measurements.

• Combined:
When Combined is selected, the selected measurements are energet-
ically combined to an over-all result. Selecting Combined always re-
sults in a single data set. For theoretical explanations please consult
Section 9.6→ Section 9.6

When you have selected the options from the above choices, you have the
following options:

Pressing this button will open an export dialog. The data set(s) can be savedExport:
in one of the following file types:

• Text file (*.txt):
A text-file stores the data as ASCII-data.

• Comma-separated values (*.csv):
Comma-separated values stores the data as ASCII-data in a format bet-
ter understood by programs.

• Excel Workbook (*.xlsx):
Excel Workbook stores the file in Office Open XML format, which can be
read by Spreadsheet programs.

Clicking this button will plot the results in the Results box. The way the dataPlot:
is presented can further be adjusted in this box, see Section 6.4.3. Note that→ Section 6.4.3
clicking the Plot button will normally overwrite the already plotted result ob-
ject, unless the Hold on button is switched on.

This button acts like a switch for the Results box. When the button is pressedHold on:
down, any additional graph is added to the current plot, without deleting the
previous graph. This way, multiple quantities for the same measurement se-
lection can easily be plotted alongside of each other. For example, when you
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want to plot the sound pressure level alongside of the sound intensity level,
you first plot the Sound Pressure Level, next you click Hold on, then you select
Sound Intensity Level from the list and finally you click the Plot button.

Note: you cannot combine the Hold on and Export functionalities. If you for ex-
ample want to export both sound pressure and sound intensity data, you have
to export them to two separate files.

6.4.3 Results

When the measurement result is plotted in the figure of the Results box you
can interact with the figure using the following buttons:

From left to right, the buttons have the following functions:

1. Reset to original view

2. Pan axes (left mouse button) and zoom (right mouse button)

3. Zoom to rectangle

4. Edit curves, lines and axes parameters

5. Save the figure

With the first 3 buttons from the left, you can interact directly with the figure.
Clicking on the Edit curves, lines and axes parameters icon results in opening
the following dialog:

Here you can specify detailed parameters of the figure, such as the range of
the axes, labels and the figure title. Moreover, if applicable, the figure plot
can be changed from lines to bars and visa versa. Text between $-signs is
interpreted as a LATEX equation.

Note: By default, all quantities except the absorption coefficient are plotted as
bars; the absorption coefficient is plotted as a line. It is possible to plot the oth-
ers as lines as well. However, it is not possible to plot the absorption coefficient
in bars. Furthermore, only lines can be plotted on both a linear and logarith-
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mic x-scale. Hence, the X-scale box is only activated when selecting ’line’ in the
Bar/line box.

Exporting the results figure can be done by clicking the last button, i.e.
Save the figure icon. The following figure formats are provided to generate
publication-quality figures:

• Encapsulated Postscript (*.eps)

• PGF code for LaTeX (*.pgf)

• Portable Document Format (*.pdf)

• Portable Netwok Graphics (*.png)

• Postscript (*.ps)

• Raw RGBA bitmap (*.raw,*.rgba)

• Scalable Vector Graphics (*.svg,*.svgz)

6.5 Waveform generator

The Sonocat Software also provides a Waveform generator that can be used
to aid you in making measurements. The Waveform generator can be found
under Tools > Waveform generator, or via the applications menu of your op-
erating system. The signal from the generator is sent to the selected output
of the workstation’s sound card. The user should provide a speaker to output
the waveform if that is desired.

6.5.1 Select waveform

Four waveforms can be selected from the following options:

• Continuous sweep, where the signal is continuous from the Sweep
start frequency to the Sweep stop frequency and back during the de-
fined Sweep time.

• Forward sweep, where the signal goes from the Sweep start frequency
to the Sweep stop frequency in the defined Sweep time.

• Gaussian noise.

• Sine wave. The wave frequency is set in the Sweep start frequency box.
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6.5.2 Signal specific

For a Continuous sweep and a Forward sweep, the start frequency can be set.Sweep start frequency:
For a Sine wave the frequency of the sine can be set here.

For a Continuous sweep and a Forward sweep, the stop frequency can be set.Sweep stop frequency:

Note: No signal will be outputted when a lower stop frequency than the start
frequency is set for a sine sweep.

For a Continuous sweep and a Forward sweep, the time length of the sweepSweep time:
can be set.

For a Continuous sweep and a Forward sweep, the sweep style can be set. YouSweep style:
can choose to output a linear, exponential or hyperbolic sweep.

For Gaussian Noise, the color can be set. You can choose for Brown, Pink,Noise color:
White, Blue and Violet noise.

6.5.3 Start

When the button Start is pressed, the generator will output the waveform sig-
nal based on the settings. Note that the settings can be changed while run-
ning. The signal will play until the button Start is pressed back.

6.5.4 Volume control

The volume can be controlled using the slider on the bottom left.

6.6 Sensor inspector

The Sensor inspector can be found under Tools > Sensor inspector and can be
used to assure proper functioning of the microphones. The sensor inspector
shows the estimated power spectral densities of the raw uncalibrated micro-
phone signals. The figure is updated in real time based on what is currently
measured.

27



Sonocat User Manual

6.6.1 Settings

The update interval uses the same settings as in the Monitor panel, see Sec-Update interval:
tion 6.2.

6.6.2 Plot

You can choose to plot either the (auto) power spectral densities on a decibelQuantity:
scale of the microphones, or the phase angle relative to a reference micro-
phone.

When the Quantity is changed from Power to Phase, the phase angle is plottedReference microphone:
for each microphone relative to the Reference microphone as chosen in this
drop-down list.

Optionally, the user can enable/disable microphones from plotting using theEnabled microphones:
checkboxes under Enabled microphones.

Healthy microphones always output power levels in the same range. When one
or more microphones is/are out of this range, it could indicate (a) malfunction-
ing microphone(s). In that event, please contact Soundinsight BV.

Note: In case the figure updates slowly, the current panel in the main window
should be switched away from the Monitor panel prior to starting the sensor
inspector. If the Monitor panel is running alongside of the Sensor inspector,
this may overload the CPU, resulting in missing figure frames.
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7 Sonocat measurement procedures

Sonocat uses eight MEMS microphones embedded in a sphere to record the
sound field. Using the recorded signals, the Sonocat Software calculates the
sound pressure level, the intensity level and direction, the sound power level,
and the sound absorption coefficient. To get these quantities as desired, infor-
mation and guidelines on how to use Sonocat at its best are presented below.

7.1 Coordinate system

The coordinate system of Sonocat is defined such that the z-axis points up-
wards when Sonocat lies on a horizontal table, see figure below. The x-axis
lies in the symmetry plane of Sonocat and is perpendicular to the z-axis,
which also lies in that plane. The y direction is chosen such that a right-
handed Cartesian coordinate system arises. The polar angle θ and azimuthal
angle ϕ are defined according to the figure.

z

x

y

θ

φ

r

7.2 Use of the tripod stand

Sonocat can be mounted on the tripod stand for point measurements. A
screw hole is available on the Sonocat which fits on the thread of the tripod.
This way, less intrusive measurements can be performed, as the body of the
operator is not in the vicinity of the sphere of Sonocat. Hence, unwanted
disturbances of the sound field can be minimized.

7.3 Measurement procedure

To perform measurements, Sonocat should be plugged to a computer or
tablet where the Sonocat Software is installed. An external sound source
can be used but it is not compulsory. For the absorption coefficient mea-
surements we, however, advice to have enough sound energy in the desired
frequency band(s) to be able to have correct results. If needed, the Signal
generator under Tools > Waveform generator (see Section 6.5) will provide→ Section 6.5
some sound options.

In the Sonocat Software all Sonocat measurements are grouped into projects.
If you want to perform a series of measurements, we advice you to first create
a project by clicking in the menu File > New project. If you want to add mea-
surements to an existing project, please, first load the project by selecting
Load project in the menu File before starting the measurements. The project
can be saved at the start of the procedure (File > Save project) or when the
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first measurement is saved (the Sonocat Software will ask you to save the
project prior to saving the measurement).
In the Project panel, you can fill in the information related to the measure-
ment.
The Monitor panel will visualise in real time the selected quantity of the
soundfield Sonocat captures.
To perform an adequate recording, appropriate options should be chosen
in the Measure panel (see Section 6.3) and a proper start delay should be→ Section 6.3
applied as desired.
Please, remember that the FFT length will affect the frequency resolution;
the Frequency resolution, Number of averages and Overlap percentage will
determine the Recording time.

Next, Sonocat can be set for a measurement. Two measuring procedures can
be followed: a point or a scan measurement (see 7.3.1 and 7.3.2).
If you are using a sound source, please, set the generator before the start of
the measurement. The measurement starts by pressing Record in the Mea-
sure panel.
Please take care to move your body away from the Sonocat sphere to mini-
mize unwanted body reflections and use appropriate ear protection in case
of loud noise. Please remember not to touch the sphere when Sonocat is
plugged in.
The analysis can be performed straight after the measurement in the Analyse
panel or later on (see Section 6.4).→ Section 6.4

Please note that all results are only valid in the range as given in the specifica-
tions, see Section 10.2.

7.3.1 Point measurement

A point measurement records the sound field in one point in space. While
performing point measurements, Sonocat should not move during the mea-
surement. It can either be mounted on the tripod stand or rest on the surface
under test for stability. Point measurements are used to measure sound pres-
sure level, intensity level and direction. The level is determined at the posi-
tion of the centre of the Sonocat’s sphere. It can also be used to measure the
sound power and sound absorption coefficient. For these last two options,
we, however, advice to combine several point measurements.

An example of measuring the Sound Intensity Level in the z-direction is
shown in the figure below:

Noise source
SonoCat

z-axis
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7.3.2 Scan measurement

Scan measurements can be conducted with Sonocat. The scan measurement
provides a surface-average of the squared pressure or sound intensity [3].
When doing a scan measurement, scan movements of the Sonocat sphere
should be as smooth as possible with an in-plane constant speed of maxi-
mally 5 cm/s, while holding the z-axis perpendicular to the surface (see figure
below). The scanning technique can be used to measure the time-averaged
pressure or intensity level, the sound power level and the absorption coeffi-
cient.

7.3.3 Measuring sound pressure

The Sound Pressure Level (SPL) can be measured as explained at the be-
ginning of the Section 7.3 by point measurement(s)(see 7.3.1). To know the
sound pressure in an area, an average sound pressure can also be measured
using a scan measurement (see 7.3.2) or combined point measurements (see
Section 9.6 for theoretical details about energetically combined quantities).
The overall level is shown in a separate bar plot. In accordance with IEC-
61672-1[2], the overall level result depends on the chosen frequency bands
and weighting. You will see that the result in the overall bar is changed when
selecting different bands and frequency weightings. The lower and upper
frequency band limits of the overall SPL are obtained from the range showed
in the Results box. Adjusting these limits will result in a different overall value.

7.3.4 Measuring sound intensity

The Sound Intensity Level (SIL) can be measured as explained at the begin-
ning of the Section 7.3 by point or scan measurement(s) (see 7.3.1 or 7.3.2).
The sound intensity in a certain frequency band can have either a positive or
negative value indicating the direction of sound energy flow. The user is able
to measure the Sound Intensity Level in the x-, y- and z-direction of a Carte-
sian coordinate system as well as in the direction of the intensity vector itself.
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7.3.5 Measuring sound intensity direction

The polar angles θ and ϕ of the intensity vector (see Section 7.1) can be de-
termined and measured as explained at the beginning of the Section 7.3 by a
point measurement (see 7.3.1). The figure below displays a schematic repre-
sentation of the value of θ and ϕ according to the position of the source.

θ

0°

180°

φ

180°-180°

90°-90°

0°

The angle θ displays the elevation angle in degrees over frequency. It goes
from 0◦ to 180◦ in the vertical plane. The 0◦ indicates an intensity vector
pointing in the same direction as the z-axis (the sound energy is coming from
"below" Sonocat). 90◦ indicates an intensity vector pointing in the xy-plane,
showing a sound energy coming from the same horizontal plane. 180◦ indi-
cates an intensity vector pointing to the -z-direction, meaning that the sound
energy is coming from "above" Sonocat.
The angle ϕ displays the azimuth angle in degrees over frequency. It goes
from - 180◦ to 180◦ in the xy-plane. The 0◦ indicates an intensity vector point-
ing in the same direction as the x-direction, the sound energy is then coming
from the "back" of Sonocat. When the source is coming from the "right" of
Sonocat its intensity vector is pointing in the same direction as the y-axis, ϕ
is therefore positive (see Section 7.1). When the source is coming from the
"left" of Sonocat its intensity vector is pointing in the opposite direction of
the y-axis,ϕ is therefore negative. In "front" of Sonocatϕ angle indicates 180◦

or - 180◦.

7.3.6 Measuring sound power

For sound power measurements, a point or scan measurement is associated
with a surface area such that the sound power can be calculated. For a scan
measurement, the surface averaged sound intensity is calculated first. Multi-
plication with the surface area will then result in the sound power. For a point
measurement, that point is considered to be representative for the specified
surface area. Hence, do not forget to set the scan area in the Measurement
Settings, see also Section 6.3.1.→ Section 6.3.1
As for the intensity level, the sound power in a certain frequency band can
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have either a positive or negative value indicating the direction of sound
energy flow. The user is able to measure the Sound Power Level in the z-
direction of a Cartesian coordinate system only. It is therefore important to
hold the z-axis of Sonocat aligned with the normal of the (scan) surface, i.e.
I · n = Iz .

Please take into account the considerations for power measurements as
stated in the ISO-9641-1 [4] and ISO-9641-2 [3] standards throughout the
measurement procedure.

7.3.7 Measuring sound absorption

An acoustic material can be characterized by the amount of sound energy
which is absorbed by the material under an acoustic load. Sonocat is able to
measure the (effective) in situ Sound Absorption Coefficientα of a material in
stationary sound fields following the procedure as explained at the beginning
of Section 7.3 either with point or scan measurement(s) (see 7.3.1 or 7.3.2).
In case of point measurement, we advice to do several points and combined
them using the combine option in the Analyse panel (see Section 9.6 for the-
oretical details about energetically combined quantities).
Sonocat should be oriented such that the z-axis points away from the surface
of interest. Keep a distance of approximately 3 cm between the centre of the
sphere and the surface. Sonocat uses the z-axis to measure the sound ab-
sorption coefficient. It is therefore important to hold the z-direction of Sono-
cat aligned with the normal of the surface.

If you are using an external source, we advice to place it at least at 1.5 meter
from the sample surface under test to have a wave as plane as possible in the
low frequency range.

Noise source

Material under measurement

1.5m

3 cm

The Results box shows the sound absorption coefficient α as a function of
frequency on a scale from -1 to +1. Hence, negative values are possible. For
a negative value of α, the model assumes emission from the surface. Due to
the theoretical model, the result forα is always in the range from -1 to +1. See
also Section 9.5.→ Section 9.5
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Note: You can also measure sound absorption real time using the Monitor
panel Section 6.2. Note that in that case the results are generally less accu-→ Section 6.2
rate since shorter measurement times are used. However, the Monitor panel
is especially useful to locate ‘defect spots’ in an absorbing surface, which are
visible by abrupt changes in the indicated sound absorption coefficient.
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8 Theoretical principles

This section provides some background information about the theoretical
principles behind Sonocat’s measurement algorithms. In order to calculate
the different quantities using the recorded signals of the eight MEMS micro-
phones located in the Sonocat’s sphere, two models are implemented. The
different steps are schematized below:

Estimating (auto- and cross-)Power Spectral Densities
(PSDs) for the 8 microphone signals

P
S
D

 (
d
B
)

Frequency (Hz)

P
S
D

 (
d
B
)

Frequency (Hz)

Calibration in level and phase

Spherical harmonic decomposition

Calculation of Levels
(pressure, intensity) and
Intensity directions

Determination of the
Sound Absorption
Coefficient in-situ 

Local plane wave method to calculate
the incident and reflective intensity 

Corrected PSDs using calibration values

8.1 Spherical Harmonics decomposition

Scattered sound field

Incident sound field

SonoCat sphere

The algorithms for the Spherical Harmonics decomposition used in the Sono-
cat Software follow more or less the same procedure as proposed in [5]. The
sound field is written as a linear combination of an incident and a scattered
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sound field, see figure above. Both fields are expanded in terms of spherical
harmonics. Applying the boundary condition on the rigid sphere (that is, the
pressure gradient in normal direction is zero) yields an expression for the to-
tal sound field. An approximation of this total sound field can be found by
truncation of the spherical harmonics terms up to fourth term (i.e. only the
zero’th and first order modes are considered). Mapping this model onto the
measured microphone signals yields now the contribution of each mode.

The coefficients of the four modes can now be used to determine the sound
pressure and particle velocity of the incident sound field. Hence, we can cal-
culate the quantity of interest (e.g. sound pressure level and sound intensity
level) in the middle point of the sphere as if Sonocat would not be in the field.

Note: The model does not account for other acoustically hard objects nearby
other than the sphere of Sonocat. Therefore, to accurately measure quantities
other than the sound absorption coefficient, it is imperative to hold Sonocat at
sufficient distance from other acoustically hard objects.

8.2 Local Plane Wave-method

Absorbing surface

Incident plane wave

Reflected plane wave

Scattered field of 
reflected plane wave

Scattered field of 
incident plane wave

SonoCat sphere

Using the Local Plane Wave-method, the local acoustic field is modelled as
two plane waves travelling in opposite direction. [6, 7, 8, 9, 10] The presence
of Sonocat in the acoustic field introduces scattering of the plane waves on
the sphere of Sonocat, see figure above. This scattering is accounted for in the
model, in such a way that the amplitudes of the plane waves are computed
as if the sphere would not be present. [11]

The amplitude of the incoming plane wave is used to determine the inci-
dent intensity; the amplitude of the reflecting plane wave to determine the
reflected intensity. The active intensity is equal to the difference between
the incident and the reflected intensity. The incident, reflected and active
power are now found by multiplying the associated intensities by the sur-
face. Hence, the sound absorption coefficient is obtained by dividing the
active power by the incident power.

Note: For each frequency, Sonocat Software checks whether the incident power
is larger than the reflected power. In the event that this is not the case, the
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active power is divided by the reflected power and the Absorption coefficient
is called an Emission coefficient. As the active power has a negative sign in that
case, the emission coefficient is plotted as a negative number (distinguishing
from the absorption coefficient).
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9 Glossary

9.1 Sound Pressure Level

The Sound Pressure Levels are calculated according to the following defini-
tion [12, p. 52]:

Lp = 10 log10

(
p2rms

p2ref

)
, (1)

where prms is the root-mean-squared sound pressure and pref = 2 · 10−5 Pa
the reference sound pressure. The root-mean-squared sound pressure is de-
fined as:

prms =

√
lim

T→∞

1

T

∫ T

t=0

p2(t) dt, (2)

where p is the sound pressure at time t.

The SPL is computed per frequency bin. From there on, the frequency
weighted SPL in a certain frequency band b is computed as:

Lp,b = 10 log10

 iu∑
i=il

p2rms,i

p2ref

+ LA/C/Z , (3)

where il denotes the lower frequency bin index of band b, iu the upper fre-
quency bin index of band b, prms,i the root-mean-squared sound pressure of
frequency bin i and LA/C/Z the frequency weighting of band b in dB.

The number of frequency bins in a frequency band depends on the chosen
frequency resolution. Frequency bins crossing a band edge are proportion-
ally divided between these two bands.

The overall Sound Pressure Level is computed according to the IEC-61672-1
standard [2], that is:

Lp = 10 log10

 bu∑
b=bl

10(
1
10Lp,b)

 , (4)

where bl and bu denote the lowest and highest frequency band of interest,
respectively. In accordance with IEC-61672-1[2], the overall level result de-
pends on the chosen frequency bands and weighting.

For the (average) sound pressure a formulation is defined:

p2rms,b,tot =

∑N
i=1 p

2
rms,b,iSi∑N

i=1 Si

, (5)

whereprms,b,i is the root-mean-squared sound pressure in band bof measure-
ment i and Si again the corresponding surface area.

9.2 Sound Intensity Level

The Sound Intensity Levels (SIL) in stationary sound fields is measured ac-
cording to the following definition [12, p. 52]:

LI = 10 log10

(
|I · n|
Iref

)
, (6)
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where I is the sound intensity vector, n the normal vector pointing in the di-
rection of interest and Iref = 10−12 Pa the reference sound intensity. The
sound intensity is known as the time average of the instantaneous acoustic
energy flow per unit area (i(t) = p(t)u(t)), that is:

I = lim
T→∞

1

T

∫ T

t=0

p(t)u(t) dt, (7)

where p and u are the sound pressure and particle velocity vector at time t,
respectively.

The Sonocat Software computes the SIL per frequency bin. The frequency
weighted SIL in a certain frequency band b is computed similar to the SPL as:

LI,b = 10 log10


∣∣∣∣∣∣
iu∑

i=il

Ii
Iref

∣∣∣∣∣∣
+ LA/C/Z , (8)

where il denotes the lower frequency bin index of band b, iu the upper fre-
quency bin index of band b, Ii the sound intensity (in the direction of interest)
of frequency bin i and LA/C/Z the frequency weighting of band b in dB.

The overall Sound Intensity Level in a certain direction is computed as:

LI = 10 log10

 bu∑
b=bl

±10(
1
10LI,b)

 , (9)

where bl and bu denote the lowest and highest frequency band of interest,
respectively. The ± character is either positive or negative depending on the
the energy flow sign per unit area in a certain band.

The sound intensity in a certain frequency band can have either a positive or
negative value indicating the direction of sound energy flow.

9.3 Pressure-residual intensity index

The pressure-residual intensity index provides a measure for the ‘reactivity’
of the acoustic field and is defined as [4]:

δp,I = Lp − LI . (10)

This quantity is also provided for all directions of the sound intensity.

9.4 Sound Power Level

The Sound Power Levels (SWL) in stationary sound fields is measured accord-
ing to the following definition [12, p. 53]:

LW = 10 log10

(
|W |
Wref

)
, (11)

where W is the sound power through a certain surface and Wref = 10−12 Pa
the reference sound power. The sound power can be determined by integrat-
ing the normal component of the sound intensity vector I ·n over the surface
S:

W =

∫
S

I · n dS. (12)
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The SWL is calculated per frequency bin. To obtain this result, the (surface
average) intensity per bin has to be determined (equation 7). Next, this sound
intensity has to be multiplied with the associated surface area to obtain the
sound power per bin. From there on, the frequency weighted SWL in a certain
frequency band b is computed similar to the SIL as:

LW,b = 10 log10


∣∣∣∣∣∣
iu∑

i=il

Wi

Wref

∣∣∣∣∣∣
+ LA/C/Z , (13)

where il denotes the lower frequency bin index of band b, iu the upper fre-
quency bin index of band b, Wi the sound power of frequency bin i and
LA/C/Z the frequency weighting of band b in dB.

The overall Sound Power Level is computed as:

LI = 10 log10

 bu∑
b=bl

±10(
1
10LW,b)

 , (14)

where bl and bu denote the lowest and highest frequency band of interest, re-
spectively. The± character is either positive or negative depending on which
direction the energy through the surface in a certain band flows to.

9.5 Sound Absorption Coefficient

An acoustic material can be characterized by the amount of sound energy
which is absorbed by the material under an acoustic load. Sonocat is able
to measure the (effective) in situ Sound Absorption Coefficient of a material
in stationary sound fields according to the following definition:

α =
Wac

Win
, (15)

where Wac is the (time-averaged or, so-called, active) sound power through
a certain (material) surface and Win the incident sound power through the
same surface. Determination of the active sound power and the incident
sound power are computed similarly:

Wac =

∫
S

Iac dS, (16)

Win =

∫
S

Iin dS, (17)

with Iac the active sound intensity and Iin the incident sound intensity.

The Sound Absorption Coefficient is calculated per frequency bin. The ac-
tive and incident sound intensity per bin are calculated. Then, the active and
incident sound power per band can be determined and thus the sound ab-
sorption coefficient per frequency band b, that is:

αb =
Wac,b

Win,b
. (18)
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The sound absorption coefficient measurements can be combined to obtain
an average coefficient, the total incident and active power has to be deter-
mined and hence the (average) sound absorption is:

αb,tot =
Wac,b,tot

Win,b,tot
. (19)

9.6 Energetically combined quantities

For measuring the sound power level of an object, multiple point and/or scan
measurements are typically combined to form a closed surface area around
the object under investigation. The level of the total sound power can be ob-
tained by selecting each measurement belonging to the set. The SWL of the
selected measurements are effectively combined as:

Wb,tot =

N∑
i=1

Wb,i, (20)

with N the number of measurements and i the measurement index.

The sound intensity level, Sound pressure level and absorption coefficient
can also be combined. In that case, the (average) sound intensity is defined
as:

Ib,tot =

∑N
i=1 Ib,iSi∑N
i=1 Si

=
Wb,tot∑N
i=1 Si

, (21)

where Sb,i is the sound intensity in band b of measurement i and Si is the
corresponding surface area. For the (average) sound pressure a similar for-
mulation is defined:

p2rms,b,tot =

∑N
i=1 p

2
rms,b,iSi∑N

i=1 Si

, (22)

whereprms,b,i is the root-mean-squared sound pressure in band bof measure-
ment i and Si again the corresponding surface area. For the sound absorp-
tion coefficient, the total incident and active power has to be determined and
hence the (average) sound absorption is:

αb,tot =
Wac,b,tot

Win,b,tot
. (23)

9.7 Frequency binning

Binning is a technique to reduce a large number of data to a smaller number
of "bins". In the case of Sonocat we provide the option to bin the data in dif-
ferent octave bands, as shown in equations 3, 8, 13, for the pressure, intensity
and power level respectively. If the frequency band choice is set to anything
other than narrow band, the narrow band results are energetically summed
up in frequency bands prior to exporting/plotting the result. For the Absorp-
tion coefficient, the incident and active intensities per bin are first summed
up in bands, and afterwards the absorption coefficient is computed from the
intensity values in each frequency band. In this case the abscissa will show
the nominal midband frequencies of the chosen frequency band.
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9.8 Weighting

Three common types of frequency weighting are provided:

A-weighting : Frequency weighting based on the relative loudness perceived by the
human ear at a sound loudness level of 40 phon.

C-weighting : Frequency weighting that is more appropriate for higher loudness le-
vels.

Z-weighting : Frequency weighting at an equal level (0 dB) for all frequency bands
(i.e. no frequency weighting).
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10 Data sheet

10.1 Sonocat dimensions

Sonocat: 365x65x45 mm (LxWxH)
USB Cable: 2.5 m
Case: 405x330x170 mm

Size:

Probe: 212 gWeight:

10.2 Specifications

Frequency range: 12 - 24000 Hz
Calibrated frequency range: 50 - 6300 Hz
Acoustic dynamic range: 29 - 116 dB(A)-SPL

Acoustic:

Sampling rate: 48 kHz
Bit depth: 24 BitsDigital:

10.3 System requirements

Operating system: Windows 7 SP1, 8, 8.1 or 10. x64 (x86_64) instruction set.
Processor: Clock speed of at least 2 GHz. At least a dual core system.
RAM Memory: 4GB or more.
Disk space: At least 150MB of free space.
USB Controller: High-speed (2.0) or newer.
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